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Install Only One Copy of the Studio Organizer

This is Very Important. Please Read this Page!

It's very important to be sure you have only one functional copy of the Studio Organizer installed on your computer. Since
the 30 day trial and the full working version are the exact same files, there is nothing more to download or install when you
purchase. Simply enter your Registration Code to disable the 30 day trial limitations.

Please be sure you have not installed more than one copy of the Studio Organizer on your computer. Also, please do not
copy the Szudio Organizer folder to another location on your hard drive as a backup. If you do either of these you will have
more than one functional copy of the Studio Organizer installed on your computer. This can create tremendous problems,
especially if you are unaware you are using two different copies of the software.

Sometimes users will download and install several copies of the free 30 day trial. They'll purchase, register, and begin to
enter their data into one copy, then a few weeks or months later open a duplicate copy of the software that only contains the
sample data. They'll see the software has not been registered and think all their data has been lost when it fact it's in a
different set of files.

Another problem might be a user enters ten new student records into one copy of the Studio Organizer. The next day they
inadvertently open a &zfferent copy of the Studio Organizer. Those ten records will be not be there. Users that have duplicate
copies of the Studio Organizer will email tech support and say their data has disappeared. Unfortunately there is no way to
merge or synchronize records from two different sets of files to correct this error.

As you can seg, it's very important to be sure there is only one copy of the Studio Organizer on your computer. Search your
computers hard drive for "Studio Organizer" and files with a ".tso" extension. If you find more than one Studio Organizer
folder open the Daza folder and examine the modification dates of the .tso files to determine which files have been modified
most recently. Delete the Studio Organizer folder that contains the older .tso files. Also be sure to delete any aliases or
shortcuts to the deleted files. Sorry, there is no way to merge or sync data from the old files.

Finally, if you're receiving an error message stating your free 30 day trial has expired, but you know you've already
registered your software, this also means you have two copies of the Studio Organizer installed on your computer. One has
been registered, and the second has been used for entering your student information. In this case, open the version which has
all of your current information and click the Purchase button and follow the steps to register the software. Then find and
delete the other, unused the Studio Organizer folder.
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the Back Up Snapshot

Backing up is your best insurance policy, and not just from computer problems. Fire, theft, flood, lightning,
and power surges are all possible culprits. Failure to back up regularly could result in the loss of months
worth of data.

The Studio Organizer makes it easy to back up every day. To create a quick backup, go to the Wizards tSo Backup 5
menu at the top of the screen and select Backup Snapshor. This will create a folder on your Desktop .
containing four backup data files. Just copy this folder to your USB flash drive. Be sure to do this every MUEZEEY Window  Help

day. It's fast and easy to backup your data. . Technical Support T |
) ) ) ) Attendance Check in A

The Backup Snapshot Wizard also creates four backup files in the Dazz folder of the Studio Organizer. Edit Attendance \%E :

These are the files that are used when you run the Restore Snapshot Wizard. : : 3 1
Quick Invoice N #Q
. . . . Record Invoice Payments  “C3F

Only one set qf backup files is stored at a time. Each backup overwrites the previous backup. So create a | Auto Dup Invoice Sy ~%D #

folder for storing each day's backup files, then backup that folder regularly to an external source. Keep — .~
several days or even weeks of backups. ]' Find Calendar \C
| Record Points 3P

Please don't keep your backups only on your computer. Just in case something unfortunate were to happen Record Promotions %R |

to your hard drive or computer always back up your data to an external source such as a USB flash " Reorder Inventory el |

1l
{ Backup Snapshot * #B |
1 Restore Snapshot i

drive, tape drive, or external backup drive. Also, take a look at Dropbox.com. It's an excellent online

backup service and it's free for low volume customers.
g

IMPORTANT! . Transfer Files 1
y u
Please do not copy the Szudio Organizer folder to another location on your hard drive. This will result in EransfecAttendaniceiOnly
more than one functional copy of the Studio Organizer being installed on your computer and if data is Import EFT Results File S
entered into two different sets of files, there is no way to merge or synchronize those records to correct this . _ . "
. . . . | Updating the Studio Organizer
error. Always be sure there is only one copy of the Studio Organizer on your computer at all times. = |

The backup files created using the Backup Snapshot Wizard modified file names that prevent them from
being opened accidentally.

Also, be sure to eject backup disks or tapes, and especially Zip disks, after a backup has been completed.
This will prevent a duplicate file from being accidentally opened and used.
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Backup Snapshot Preference & Restoring

Backup Snapshot Preference
On the General folder tab of the Preferences screen select your backup snapshot options. Select Baciup ar

Shutdown every / day and the Studio Organizer will be backed up every time you close the program. A
numbered backup folder will be placed on your desktop, unless the "Do Not Create a Backup Folder on
Desktop" box is checked. Copy this folder to a USB flash drive and take it home for safe keeping.

Backing Up Last Backup (#1) was on Wednesday, February 9, 2011.

Backup at Shutdown every | 1 days

[] create Smaller Backup Files (takes longer)
[:| Do Not Create Backup Folder on Desktop

(Backup Now)
Restoring a Backup Snapshot
In order to restore a backup, you must first have created backup files using the Backup Snapshot wizard.
IMPORTANT!
Be sure to use only the Master password provided with your Registration Code to perform these steps.
Admin level passwords will not restore your data correctly.
To restore a snapshot, open the Studio Organizer with the Master password then go to the Wizards menu WGZICEY Window Help
Technical Support T ||
and select Restore Snapshot.
Attendance Check in N #A
. . . L. Edit Attendance X BE
This will completely empty your files, and import the data from the backup files located inside the Daza i T
. . uicK Invoice
folder. The backup files inside the dated backup folder on your Desktop are not used. Record Invoice Payments  ~C3F
Restoring cannot be undone. #  Auto Dup Invoices %D |
! Find Calendar C a
{
1 Record Points 3P ':
ALWAYS Backup to an External Source | Record Promotions xR
Backing up is essential insurance. Computers are far from perfect. Hard drives die, computers are _| promerinventory i)
vulnerable to circuit board failure, power surges, fire, theft, flood, earthquake... you name it.

—

Transfer Files

Please be sure to backup your data to an external source on a regular basis. See the next page... Thinshar Atrandance Only

~

Import EFT Results File

eT—

Updating the Studio Organizer
—_—
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What about Backup Software?

Backup software is highly recommended.

Since there are many products available ask your computer consultant for recommendations. Here are some important points
to keep in mind when using backup software:

» Always Quit the Studio Organizer before backing up.

» Always eject backup disks or tapes, and especially Zip disks, after a backup has been completed. Verify that there is no
way to inadvertently open a duplicate or backup database file.

* Ask your consultant about multiple rotating backups for maximum insurance. That means a backup tape or disk for
Monday, and entirely different tape or disk for Tuesday and so on. That way if Friday's backup has some problem, you can
always try Thursday or Wednesday's backup.

» Ask your consultant about offsite storage of your backup media.

* Ask your computer consultant to provide training for your backup and restore procedures. Your entire staff should know
how to backup, and at least one person in the office should know how to restore. Perform a trial restore just to be sure.

* Sorry, the Studio Organizer.com does not support and assumes no responsibility for your third party backup hardware,
software or procedure.

* Backing up is the user's responsibility.
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Updating the Studio Organizer is Different...

When a new version of the Studio Organizer is released you can easily transfer your data into that version, but the updating
process is different than other software programs.

That's because the Studio Organizer was built using FileMaker Pro software, and oddly enough, FileMaker Inc. has never
devised a way for end users such as yourself to easily update when a version is released.

Most programming languages keep user data in one set of files, and data entry screens and reports in another set of files. So
when an update is released, all the user has to do is download the new data entry screens and reports, and a convenient
installer program puts them in the correct location. The user opens the software and all of their data appears exactly as it was,
but is displayed in the new data entry screens and reports. Simple!

FileMaker Pro, for some strange reason, keeps user data, data entry screens and reports all in one file. This means the only
way to get your data into a newer version of the Studio Organizer is to install the new version on your computer, then zzpors
your data from the old version to the new version.

This creates a number of potential problems. First, users who have not read these paragraphs will download a new version,
open the new update, and think all of their data has been lost!

Second, users must install the Studio Organizer AGAIN, and that means two or more copies of the Studio Organizer will be
installed on the computer's hard drive. This creates a potentially confusing housekeeping chore. Users must delete unneeded
files, folders, shortcuts and aliases. If a user does not follow the updating instructions, he'll end up with multiple copies of the
Studio Organizer installed on his computer.

The third potential problem is importing errors can occur. To overcome these limitations, the Studio Organizer includes an
Updating Wizard and data verification that greatly reduces importing errors.

Knowing these limitation exist, why not use a different programming language? Because FileMaker Pro is very, very stable.
It runs remarkably well and has for over two decades. There isn't anything else out there that's as powerful, stable and
affordable. So the updating dilemma is unfortunate, and not user friendly, but it's not a big enough fly in the soup to throw
the whole bowl away.
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Updating the Studio Organizer

You can update from any version of the Studio Organizer to the most current version. It is not necessary to install previous
updates. Your Registration Code will transfer along with your data so it's not necessary to reenter your Registration Code. Be
sure to install each Studio Organizer update when it becomes available. Updates contain new features, interface &
documentation improvements and bug fixes. Before updating, print and read the Version History on the web site for a
complete list of what's been added and how to use the new features.

Master Password Only

Even if you have created other passwords, the first time you open a new version of the Studio Organizer, you must open it
with the Master password. This is because the passwords you have created are not included in the version you download
from the web site. Any passwords you have created are transferred during the updating process and will be available after
you have successfully updated.

Updating Instructions

To update, open the Studio Organizer with the Master account name and password, then go to the Wizards menu at the top of
your computer screen and select {pdazing the Studio Organizer. All the instructions are right on the screen, but here's a brief
overview of what you'll do:

Step 1 Open the version of the Studio Organizer you are currently using with the Master account name and password. Go to
the Wizards menu and select {paating the Studio Organizer. Click the Begin Wizard button and read the instructions on the
screen. When you click the Begin Updating button this backups all your data and temporarily copies the backup files to your
computers Desktop.

It also locks the current version so if you were to open it accidentally you'll see an error message stating this is an old
version. (Click Unlock to open the file.)

Step 2 Next you'll be taken to the Updating web page. Follow the instructions on the screen to download and install the new
version of the Studio Organizer.

Step 3 Open the new version of the Studio Organizer with the Master password provided with your Registration Code. Click
Register Later, then go to the Wizards menu, select {pdating the Studio Organizer and click Finish Wizard, read the
instructions, then click Finish Updating. This copies the backup files from your computers Desktop into the new the Studio
Organizer Daza folder, deletes the backup files from the Desktop, then imports your data into the new version.

Be sure to follow the Cleaning Up instructions carefully to prevent accidentally opening the old version.
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Networking the Studio Organizer

Networking is a great way to share the Studio Organizer with everyone in your office, but it requires additional hardware and
software. Networking is an optional feature which allows you to share the Studio Organizer in real time between two to nine
computers on a network. (If you wish to network more than nine computers, please contact technical support for details.)
You'll need a professional to set up the wiring and hubs.

The Studio Organizer.com does not charge any additional fees for a user to network, however, FileMaker Pro software must
be purchased and installed on each computer. You can purchase the FileMaker Pro 11 software from any source you wish,
such as www.softwaremedia.com. The cost is roughly $300 per computer. (Do not purchase the Advanced or Server
versions.)

Since it's not possible to record attendance while using other features of the Studio Organizer on a single computer,
networking is a great way to dedicate a computer to attendance check in, but it's not required. To spare you the expense of
networking, the Studio Organizer offers you the ability to dedicate a computer to attendance recording without networking.
Please read A#zendance Computer: No Network Reguired in the built in Help or the Working With Data tutorial.

Purchasing and installing the FileMaker Pro software allows users to network as well as create PDF files, export to Excel,
and more.

FileMaker Pro Updates and Upgrades

From time to time FileMaker Inc. releases updates to it's software. An update is a minor change to current version (for
example FileMaker Pro 11v01 users #pdare to version 11v02) and users can usually download updates free of charge from
www.filemaker.com. The network administrator should always download and install minor updates to FileMaker Pro on
each computer using the Studio Organizer.

Less frequently, FileMaker Inc. will release an upgrade -- which is a newer version with a higher version number. For
example FileMaker Pro 10 users zpgrade to FileMaker Pro 11. Upgrades offer a significant number of new features and
improvements, and as a result FileMaker Inc. charges an upgrade fee, usually 50% of the original purchase price.

If an upgrade is required to use newer versions of the Studio Organizer, this will be noted in the Version History. The user

can choose not to upgrade FileMaker Pro and continue to use an older version of the Studio Organizer which does not require
the upgrade, or purchase the upgrade. FileMaker Pro upgrade costs are the responsibility of the user.
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Setting Up Your Network

Network Hardware Required

Since networking is a job best left to a professional, please ask your computer expert to print this article. In order to network
the Studio Organizer, you must have a computer network installed at your location. This requires additional hardware such as
a router or hub, wiring, ethernet cards, etc. If you have questions, please email technical support but be advised, the Studio
Organizer tech support probably won't be your best bet if you have network hardware or operating system questions. We'll be
happy to help, but our area of expertise is with the Studio Organizer software.

FileMaker Pro Software Required

The StudioOrganizer.com does not charge any additional fees for a user to network, however, FileMaker Pro software must
be purchased and installed on each computer. The Studio Organizer ships with a 7zzzime version of the FileMaker Pro
software. The runtime is limited in that it does not allow users to create database files, network, create PDF files, or export to
Excel.

So when you purchase the FileMaker Pro software, you're buying a powerful, easy to use tool you can use to create your own
databases. You can purchase the FileMaker Pro software from any source you wish, such as www.softwaremedia.com. The
cost is roughly $300 per computer. (Do not purchase the Advanced or Server versions.) You can also purchase directly from
FileMaker.com if you'd like a volume discount.

Please note there is no way to bypass the purchase of the FileMaker Pro software. Do not attempt to use any form of File
Sharing or Remote Access software to share the Studio Organizer files. This will result in damage to your files.

After you have installed your computer network and purchased one copy of FileMaker Pro per computer you can begin to
configure your computers.

Step 1 Install FileMaker Pro

Install the FileMaker Pro software on each computer. If each copy of FileMaker Pro has a unique Registration Code, use
each FileMaker Pro Registration Code only once. Do NOT re-use a FileMaker Pro Registration Code unless it is a multi-user
Registration Code.

If you have purchased one Registration Code for many computers (a volume license) do not attempt to install FileMaker Pro
on more computers than your volume license allows. This will cause networking to fail.
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Step 2 Designate a Server

Pick one computer that will be the server or host. We'll refer to this computer as the se7ver, but that doesn't
mean this computer should be a high end computer or one that's marketed specifically as server. It should
just be a fairly fast machine and it should be the one where the Studio Organizer will be running in the
foreground most of the time. As soon as you switch to a different program on the server the performance of
all the guest computers will drop significantly.

Your server will be the only computer that has the Studio Organizer files installed on the hard drive. The
guest computers should only have the FileMaker Pro software installed on them.

Once you have selected a computer to be the server, install the FileMaker Pro software and the Studio
Organizer on this computer. If you are using FileMaker Pro Server, place the Studio Organizer folder
inside the FileMaker Pro Server folder.

All of the other computers you will network will be called gwess computers. Do not install the Studio
Organizer on any guest computers.

Step3 Remove the Runtime & Move Plugins

Open the Studio Organizer folder on your server.

PC users open the Daza folder.

Delete the Studio Organizer application. The application file is named #ze Studio Organizer 5v.XX, where
XX is the version number. This is a runtime version of FileMaker Pro which is not networkable. Trash it.
This is done as a precaution to prevent the Studio Organizer files from being opened with the runtime
application.

Next, there are several plugins which are automatically installed with the Studio Organizer. Network users
must move these files on the server, and copy them to each guest computer.

To do this, open the £xzensions folder inside the Studio Organizer Daza folder and copy these files to a
USB flash drive or shared network folder: SimpleDialog, SimpleFile, SimpleSound and Blowfish.

the Studio Organizer 5v20

w the Studio Organizer 5vXX

Working with Data p. 12



precr e -
OOUO Open File
[« » ) (2sf=/m) [ the Studio Organizer 5v01 a Q
DEVICES B Name A| Date Modified
B jeff's iMac ¥ _Sv0l.tso Yesterday A
;)' Macinto... [y -att.tso Yesterday '
g et A W _elp.tso Yesterday !
fy _Ibl.tso Yesterday !
§||5R[D 'y _oto.tso Yesterday !
I jeff-pc "y _rsc.tso Yesterday :
PLACES Ny _tfr.tso Yesterday .
A Desktop » [ Extensions Yesterday '
O fejj » [ Student Photos 3/11/10
(3 Documents LY {J the Studio Organizer 5vXX Yesterday v
: | ETTE——
ShowlAIFVEL EGI h ( Remote... )
FileMaker Pro Files
Tab-Separated Text Files
Comma-Separated Text Files
Merge Files (_Cancel ) Open

Place copies of these files in the Zxzensions folder inside the FileMaker Pro application folder on your server. (Skip this step if you are using
FileMaker Server.) The FileMaker Pro software may have been installed into the Program Files (PC) or Applications (Mac) folder, these are the
default installation locations but you can change these when installing the software.

Step 4 Share the Srtudent Photos Folder

Inside the Srudio Organizerfolder is the Szudent Photos folder. Share this folder. Make it readable and writeable for all users of the Studio
Organizer.

Step 5 Launch the Studio Organizer on the Server

Launch FileMaker Pro, go to the File menu and select Open.

PC Users: Click on the "Files of types:" drop down menu, scroll zp and select "All files (*.*)"

Mac Users: Click on the "Show:" drop down menu and select "All Available."

Locate the Srudio Organizer folder.

PC users open the Daza folder.

Locate and open ' 5vXX.tso' (XX is the version number). When prompted for a password, enter the Master account name and password.
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- W W
FileMaker Network Settings‘

T W OWE W w W [®

FileMaker Network Settings

]

Network Sharing: () Off

FileMaker access via FileMaker Network —
Currently open files

_tfr.tso
_elp.tso
_att.tso
_bl.tso
_rsc.tso
_oto.tso

This will open the Studio Organizer. When the opening sequence is complete you'll be viewing the Main Menu.

Step 6 Enable File Sharing
Go the File menu and select Sharing -> FileMaker Network...
Turn Network Sharing On.

Under "Currently Open Files" select each file, then apply these settings:

Turn on Network Sharing to share your open files using TCP/IP.

@ On

TCP/IP Address:  192.168.1.104

Network access to file
File: *_SvXX.tso"

©) All users
(") Specify users by privilege set Spedify...
(") No users

["] Don't display in Open Remote File dialog

This file is being used by 0 users. To send users a message,

dick the Send Message button.

Send Message... OK ] [ Cancel

_S5vXX.tso = All Users, Do NOT check "Don't Display in Open Remote File Dialog"
_att.tso = All Users, CHECK "Don't Display in Open Remote File Dialog"

_oto.tso = All Users, CHECK "Don't Display in Open Remote File Dialog"

_Ibl.tso = All Users, CHECK "Don't Display in Open Remote File Dialog"

_elp.tso = All Users, CHECK "Don't Display in Open Remote File Dialog"

_rsc.tso = All Users, CHECK "Don't Display in Open Remote File Dialog"

_tfr.tso = NO Users, CHECK "Don't Display in Open Remote File Dialog"

Click OK. You are now sharing your the Studio Organizer files.
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— e— )

Working with Data p. 14



Ideally the only program running on the server should be FileMaker Pro. It should be in the foreground at
all times. This may not be possible at all times, but know if you switch to another program or minimize
FileMaker Pro, this will slow down the guest computers.

Also, be sure the Studio Organizer files have opened completely on the server before connecting guests.
When the opening sequence has been completed, you'll be viewing the Main Menu.

Step 7 Create a Server Account & Staff Passwords

If you would like to protect the server so it can be left unattended and no one can tamper with the Studio
Organizer, you can create a special password just for opening the server that has access to only the Main
Menu.

To do this, from the Main Menu, click the Staff button

Create a new staff record with a first name of Server, last name of Setup.
Click the Passwords and Access folder tab.

Click the + button to create a new password for this record.

Account Name = Server Setup

Access level = Staff

Password & Hint = {your choice}

Access = Uncheck all boxes except the Main Menu

While you're on the Staff screen, you can create staff records and passwords for each staff member. Since
the Master password cannot be changed, it should never be given to staff members. Creating passwords is
discussed in detail in the Sc/zo0/ Setup guide.

Now Quit/Exit FileMaker Pro and open the Studio Organizer as described in Step 4 above, then enter the
Server Setup account name and password you've just created. Now, only the Main Menu can be displayed

on the server until you quit and re-open with the Master password.

Note: If you quit the Studio Organizer on the server, all guests will be prompted to disconnect. All guests
must exit before the server will close the program.

the Studio Organizer 5v20
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Step 8 Configure the Guests

Install FileMaker Pro on each guest computer.

Do not install the Studio Organizer on any guest computers.

Mount the Szudent Phoros folder, which is a shared volume located on the server.

Just as you did on the server, copy the plugin files into the Zxzensions folder inside the FileMaker Pro
application folder of each guest computer: SimpleDialog, SimpleFile, SimpleSound & Blowfish.

Once FileMaker Pro has been installed and the plugins copied into the £xzensions folder, you can now open
the Studio Organizer on your guest computers. You won't use file sharing or your personal network to open
any files. You'll use the FileMaker Pro software to connect to the Studio Organizer files running on the
server.

Step 9 Launch the Studio Organizer on the Guest Computers

To do this, go to each Guest computer and complete these steps:

Open FileMaker Pro, then go to File and choose Open, then click the Remote button in the bottom right
corner of the screen.

View: Local Hosts
Hosts: {Select your server}
Available Files: 5vXX.tso

Select the 5vXX.tso file, then click Open, and enter the account name and password you wish to use on
this guest computer. Feel free to use the staff passwords created in Step 7. Do not use the Master password
or give it to any staff members. The Master password cannot be changed and should be protected.

the Studio Organizer 5v20

eno (] Extensions =
5 items, 337.2 GB availabl —Or
A
[ [Frocn |
a i
% |
; ' i
BlowFish.fmplugin SimpleDialog.fmplugin ‘
|
| PLUGIN | | PLUGIN |
SimpleFile.fmplugin SimpleSound.fmplugin S
OO, Open Remote File
View: | Local Hosts '
Hosts
Jeff-PC (192.168.1.104) Available Files Filter: Q
Jjeff's iMac (192.168.1.100) '*

(‘Add to Favorite Hosts... )

("Add to Favorites )

Network File Path: fmnet:/192.168.1.104/_SvXX

Example - fmnet:/

hostiPAddress /fileName

e
Cancel Open
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Step 10 Create a Shortcut or Alias on each Guest Computer

For convenience, create a shortcut or alias of the FileMaker Pro application and place it on the desktop of
each guest computer. To do this, open the FileMaker Pro folder and create a shortcut or alias of the
FileMaker Pro application file and move the shortcut or alias to the Desktop.

Now you're ready for your guests to open the Studio Organizer. Here are the steps:

1) The server must be hosting the files.

2) The guest will double click the FileMaker Pro alias or shortcut, or open the FileMaker Pro software in
any fashion you wish.

3) After FileMaker opens, select Open from the File menu, then click the Remote button.

4) Select the Host, then double click 5vXX.tso.

5) Enter a staff account name and password you've created.

Congratulations! You're now ready to begin to use the Studio Organizer on each of your networked
computers.
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Important Networking Facts

Inserting Student, Staff and Inventory Photos or Images

In order for student, staff and inventory photos or images to appear on all computers on the network, they must be stored
inside the shared Szudent Photos folder on the server. This shared volume must be mounted on each guest computer. Photos
will not display if the shared Srudent Phoros volume is not mounted prior to launching FileMaker Pro.

Photos and images can only be inserted from a guest computer by selecting the image from the shared Szudens Photos folder.
To insert a photo go a guest computer and 1) single click the + sign to the right of the student photo field. 2) In the Open
dialog box that appears, locate and open the shared Student Photos folder that resides on the network. If you cannot view the
shared Student Photos folder, ask your network administrator to correct this. 3) Select the correct image file, then click the
Open button.

Mixed networks (Macs and PCs) will only display student photos if the "Store only a reference to the file" box is unchecked
when the photo is inserted. Use caution with this option since this stores the entire image file in the database. Images larger
than .5 megabyte should not be used. Large files will dramatically decrease the screen refresh time of guest users. Also,
FileMaker Pro has a known problem with storing many large (greater than 1 megabyte) image files and file corruption is
common.

Here are some important network reminders:

* There is no Save command. All of your data is automatically saved to the server when you switch to a different screen, hit
the ENTER key on your number pad, or quit.

* Only one user can modify a record at a time. Hit the ENTER key on the number pad to save the changes you've made to a
record and release that record for another user to modify.

* If the server is not running the Studio Organizer in the foreground, all guests will experience slower than normal response
times.

* Large graphic files inserted with "Store only a reference to the file" unchecked with cause slow screen refreshing. Images

larger than 1 megabyte are especially problematic and prone to corruption. Use caution.

* All guests must quit the Studio Organizer before the server can shutdown.

* Transferring files and updating to a new version of the Studio Organizer must always take place on the server, using only

the Master password.

* Do not give out the Master password to staff members. It provides full access, and cannot be changed.
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Transferring Files Between School & Home

REGISTERED USERS ONLY

Would you like to be able to take your the Studio Organizer data home for the evening, do some work, then bring all your
changes back to the school computer? You can use the Transferring Files Wizard to move your data between any computers
you wish. You can even transfer data from a Macintosh to a Windows computer.

Many school owners do this on a daily basis. It's not difficult, but it does require a bit of computer know how.

IMPORTANT!

You can use the Studio Organizer on only one computer at a time. With the exception of attendance recording you can't use
the Studio Organizer on two different computers, then later merge the data back into one file. If you wish share the Studio
Organizer on several computers, please read the Nesworking article in the Working With Data tutorial or the built in Help.

What if your staff would like to run a report? Or lookup a phone number while you're working on your data at home? No
problem, as long as they don't edit or add any student data.

Your Registration Code
When you update, transfer files or restore a backup snapshot, your Registration Code automatically transfers along with all
of your other data.

Master Password Only
Please be sure to use only the Master password provided with your Registration Code to perform these steps.

Network Users
Transferring files must always be performed from the server computer, with no guests connected.

Installing the Studio Organizer

First, it's important to use the same version of the Studio Organizer on both computers. If you've already downloaded the
Setup tsol.exe or Install 1So.zip file, you can copy that file to a USB flash drive and install the Studio Organizer on the
second computer. Please do not transfer files between two different versions of the Studio Organizer. If you have 5v12 on
one computer and 5v15 on the second computer, this will result in several error messages and possible loss of data.
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Installing the Bar Code Font
If you'd like to print bar codes, the Code 39 bar code font must be installed on each computer. The Code 39
bar code font and instructions are inside the Aar Coding folder inside the Srudio Organizer folder.

What You'll Need
To transfer the Studio Organizer back and forth between school and home, you'll need some way of
copying large files, like a USB flash drive, or Dropbox.com (a free online backup service.)

Burning CD's to transfer files is not recommended, since Windows users will find all files are locked when
copied from a CD. Emailing yourself the files in not recommended because the files are too large, and may
be damaged in transit.

The Studio Organizer.com does not provide training or support for copying files since this involves using
your operating system. If you're not sure how to copy files, please ask your computer consultant for hands
on training.

Step1 Begin Transfer Files Wizard

Let's say you have a /Zome computer and .sc/z00/ computer, and it's the school computer that has your
current data on it. Open the Studio Organizer with the Master password on the school computer, go to the
Wizards menu and select "Transfer Files."

Read this instructions on the screen. Be sure to check both the "Include Student Photos Folder" check box,
and the "Include Attendance Data" check box, then click the Start button. This will place copies of your
backup files on your computers Desktop.

Quit the Studio Organizer. Be sure to let your staff know not to make any changes.

Step 2 Copy the Backup Files from the School Computer

Locate all four Backup files and the Szudens Photos folder on your computers Desktop, and copy them to
your USB flash drive or copy them into your Dropbox.com folder.
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Step 3 Copy the Backup Files to the Home Computer
Now take your USB flash drive home and if the Studio Organizer is not installed on that computer, install
the same version on the home computer. Do not open the software just yet.

Next, copy the files from the USB flash drive or Dropbox.com folder onto your home computers Desktop.
Be sure you copy the files to your Desktop -- do not create shortcuts or aliases of the files.

Step 4 Finish the Transfer Files Wizard

Now open the Studio Organizer with the Master account name and password on the home computer. If this
1s the first time you've opened this copy of the Studio Organizer, you will be asked to register the software.
Click Register Later. Your Registration Code will be transferred along with your data.

Go to the Wizards menu at the top of the computer screen and select "Transfer Files." Be sure to check both
the "Include Student Photos Folder" check box, and the "Include Attendance Data" check box, then click
the Finish button.

This will move your backup files and Szudens Photos folder into your the Szudio Organizer folder, then
delete those files from your computers Desktop. Your Registration Code is included with your data, so
there's no need to register again, unless you're transferring data with an expired Registration Code.

Now you're in business on the home computer. You can record attendance, print letters, certificates, do
whatever you wish. Once your done working on the files at the home computer, you'll simply perform the
same process again.

» Wizards -> Transfer Files -> Start creates backup files on your Desktop.

* Copy them to a USB flash drive or your Dropbox.com folder.

* Go to the school computer, copy all the backup files onto the School computers Desktop, overwriting the
old files.

* Open the Studio Organizer with the Master password and begin the Transferring Files Wizard.

* Click Finish.

That's it. Now all the changes made on the home computer have been transferred to the school computer.
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More About Transferring Files

Take Your Data Home, but Keep Recording Attendance
Yes, you can take your data home for the evening and keep recording attendance at school.

While at home, you can make changes to anything except attendance data.

Meanwhile back at school, only attendance records will be saved on the school computer. Your staff cannot
change any other information. They can create reports, lookup student info, etc. but any changes they make
will be lost. So if something needs to be changed, have them leave you a note.

To use this feature you'll perform the Transferring Files steps, but when you run the Transferring Files
Wizard unc/eck the "Include Attendance Data" check box, both when Starting and Finishing the Wizard.
This will transfer all of your data erceprthe attendance data file.

Skip Transferring Student Photos

If you've been transferring files between computers for a while and none of your student photos have
changed, you can uncheck the "Include Student Photos Folder" check box. This will speed things up when
you copy your backup files between computers because the Szudent Phoros folder can get quite large.
There's no need to move it around if both computers already have the same Szudent Photos folder with the
same files.

Please note: The image files for your Student photos must always be stored in the Szudent Photos folder. If
these files are anywhere else on your computer, they will not transfer properly when transferring files or
updating to a newer version.

Avoid Duplicate Installations

At all times there must only be one copy of the Szudio Organizer folder on each computer's hard drive.
Failure to diligently observe this rule will result in two entirely different copies of the Studio Organizer
installed on your computer, and you could end up entering data into two different sets of files. This is
explained in detail in the beginning of the Sc/o0/ Sezup tutorial. Please be sure you understand this
important housekeeping chore. It's a very common technical support issue -- knowledge is power. Don't let
this happen to you.
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Updating to a New Version when Transferring Files

If you are regularly transferring files between two computers and a new update to the Studio Organizer is
released, you must update both computers. Transferring File between different versions of the Studio
Organizer on a regular basis is not recommended.

Please print and read Zransferring Files... Between School And Home before proceeding.

Master Password Required
You can only use the Master password provided with your Registration Code to perform these steps.

Updating to a New Version of the Studio Organizer
When a new update of the Studio Organizer is released you can install the update on both the school and
the home computers.

First, go to the computer which has the most recent data, let's say this is the school computer, and you've
been using Version 5v01, and you'd like to update to Version 5v02.

Open the Studio Organizer 5v01 on the school computer and go to the Wizards menu. Select "Updating the

Studio Organizer." Follow these steps to update and transfer your data into Version 5v02. Once the school
computer has been updated to Version 5v02 you're ready to move your data to the home computer.

Run the Transferring Files Wizard on the school computer, be sure to check both the "Include Student
Photos Folder" and "Include Attendance Data" check boxes, then click Start. Copy the backup files to your

USB flash drive. (Please print and read Zraznsferring Files... Between School And Home in the built in Help

for all the details.)
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Next go to the home computer and delete the entire the Szudio Organizer folder from your computers hard
drive. Also delete all aliases or shortcuts to the old program and delete any old backup files which may be
on the Desktop. Don't worry. All of your data on your USB flash drive.

Next, download and install the Studio Organizer 5v02 on the home computer. If this computer does not
have an internet connection, you can download the Studio Organizer 5v02 installer file from a computer
connected to the internet, then copy that installer file on to you USB flash drive. The installer file is called
Setup 1505.exe for Windows users and Zzszall 1505.zip for Mac OS X users.

After you have the Studio Organizer 5v02 installed on the home computer, copy the backup files from the
USB flash drive to the Desktop of the home computer.

Open the Studio Organizer on the home computer with the Master password, go to the Wizards menu and
select "Transfer Files." Be sure to check both the "Include Student Photos Folder" and "Include Attendance
Data" check boxes, then click Finish.

That's it! You just updated both computers.

Registration Code Transfers with Data
When you update, transfer files or restore a backup snapshot, the Registration Code transfers along with all
of your other data.

There's no need to enter your Registration Code before hand, however if your Registration Code has

expired since your last backup and you restore that backup, it will be necessary to enter the new
Registration Code.
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Dedicating a Computer to Attendance Recording

If you would like to have a computer that only records attendance and you don't mind gathering your attendance data at the
end of the day, you don't need to network, you can simply set up a computer at the front desk. By placing a bar code scanner
within reach and the computer monitor facing the student, students can check themselves in and view the greeting screen.

Networking is by far the best way to share your data between computers, but networking costs money. This workaround is
free, but your data is not automatically updated; you'll use helpful Wizards as explained below.

Please print and read 7ransferring Files... Between School And Home in the built in Help before reading these instructions.
This is a bit technical, so if you don't understand these instructions please do not proceed without asking your computer guru
for assistance.

The Front Desk computer will oz/y be used to record attendance and the Office computer will be used for everything else.
No attendance additions or editing should be done on the Office computer while the Front Desk computer is recording
attendance. Any changes to attendance records made on the Office computer will be overwritten at the end of the day when
you can gather all the attendance data from the Front Desk computer and transfer it to the Office computer.

Setting Up the Front Desk Computer
First, follow the Zransferring Files Between School And Home instructions to get all of your data onto the Front Desk
computer.

Next, open the Studio Organizer on the Front Desk computer and start recording attendance.

At the end of the day, or whenever you'd like to get your attendance data into the Office computer, go to the Front Desk
computer, exit out of attendance check in mode, and select "Transfer Attendance Only" from the Wizards menu. Read the
on-screen instruction, then click Start.

This will place a copy of your attendance backup file on your computers Desktop. The file is called Backup azr iso.
Copy this file to your USB flash drive and take it to your Office computer. Copy the Backup arr tso file from your USB

flash drive onto the Desktop of the Office computer. Or use your computer network to transfer the Backup atr fso file to
the Office computers Desktop.
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Open the Studio Organizer on the Office computer and go to the Wizards menu and select "Transfer Attendance Only" click
Finish.

This will move all of the attendance data collected on the Front Desk computer into the copy of the Studio Organizer you
have installed on the Office computer.

Go ahead and review this data, make changes, add students or do anything you wish. Just be sure the Front Desk computer is
not being used to record attendance.

When it's time to start recording attendance at the Front Desk again you'll want to transfer all of your data to the Front Desk
computer. This is done so all the changes you've made, including new student records will be available on the Front Desk
computer. Follow the Transferring Files Between School and Home instructions and transfer your data to the Front Desk
computer. Now all the new students that recently enrolled can begin recording attendance.

If a student's record is not on the Front Desk computer a Szudens Not Found error message will appear when they try to check
n.

WARNING!

Do not do any data entry other than attendance recording on the Front Desk computer. Users at the Front Desk can look up
information, print ID cards, or create reports. They cannot create new records or modify data. This machine will 07/y record
attendance.

While the Front Desk computer is in use recording attendance, do not enter or edit any attendance records on the Office
computer. These changes will be lost when you transfer the attendance data from the Front Desk computer.
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Installing on a Computer with No Internet Connection

Would you like to install the Studio Organizer on a computer that is not connected to the internet?

Option 1

If you have an internet connection and a USB flash drive you can download the installer file and copy it to )
your Flash drive. d’
To do this, visit www.StudioOrganizer.com and download the most current version. When asked if you'd

like to Save or Run the file, select Save and select the Desktop as the location for the file. Begin
downloading. Setup tSo5.exe

The installer file is called Sezp £505.exe tor Windows users and Zzsza// £S05.zzp for Mac OS X users.

When this file has successfully downloaded to your Desktop, copy the installer file to your USB flash
drive. You can now take the USB flash drive to the computer that does not have an internet connection and
copy the installer file onto the Desktop. Do not attempt to run the installer file from the USB flash drive.
Instead copy it to your computers Desktop, then run the installer.

Option 2

If you already have the Studio Organizer installed on one computer, you can simply copy the entire the
Studio Organizer folder to a USB flash drive, then go to the computer without an internet connection and

copy the Szudio Organizer folder from the USB flash drive on to the Desktop. l .

The bar code font will not be installed on this computer so be sure to follow the Zzsza/ling 7%e Bar Code _a
Fontinstructions in the built in Help. Install_tSo5.zip

Option 3 S ————

If you have the most current version on CD, simply take the CD to this computer and install the software
directly from the CD. CD's can be purchased from the online store.
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Importing Data into the Studio Organizer

Can I import data into the Studio Organizer?

Yes! If your existing software or spreadsheet allows you to export text files, you can import into the Studio Organizer.
However, not all of your data will go gracefully from one program to another. You should be able to import student names,
addresses, birthdays, that sort of thing with a bit of trial and error. Invoices, payments, and attendance data will more than
likely be problematic.

It all depends on how well the data fields match up. It may take a few attempts to get your import fields to match up
properly, so plan on experimenting and deleting. Importing is never perfect. Since importing and exporting data requires
quite a bit of trial and error, it's strongly suggested that you ask your computer guru for assistance with this process.

Export Format Options

When exporting data from other sources, experiment with your exporting options. Compatible formats: tab separated text,
comma separated text, SYLK, DIF, WKS, BASIC, Merge, Data Access Manager. The Merge format is recommended
because it includes the field names. This will make matching up data fields easier.

Proper Password Required

The Studio Organizer allows 30 day trial users to import data, just to see how the process will go before purchasing.
Importing will require the Master or Guest password. The Staff password is not permitted to import.
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Importing Terms

] Phones |
| Students | ([Phone |Extension [Type lzk_Link_fk |
INameFirst INameLast llzk_Link_pk | [[818-962-4587 || |Home 11000 l
[Bill [Smith [1000 | [818-689-4568 | Cell [1000 |
|Fred \Jones 1001 | [[818-968-9874 112 Work |l1000 |

|719-458-8596 || |Home 11001 |

Fields, Tables and the Relational Key

Fields are place holders for data. Examples of fields would be "NameFirst" and "NameLast." Tables are a collection of fields. The Students table
contains the "NameFirst" and "NameLast" fields, along with many other fields. Any field starting with the letter 'z' is used for programming
purposes, and normally would not be a field your data would be imported into, with one exception.

That exception is the field: zk Link pk. This number field is a unique identifier for each student. In database terms, it is referred to as the primary
relational key. If you will be importing data into more than one table, you must have a unique zk Link pk for each student.

Another table is the Phones table, which contains telephone fields such as "Phone," "Extension" and "Type," as well as a "zk Link fk" field. This
last field is the /orezon relational key, or link between the Students table, and the Phones table. The use of the word foreign only means there can

be many occurs of the same key.

There can be many Phone records for a student. Using the relation keys as a link, we know Bill Smith has three phone numbers, and his home
phone number is 818-962-4587. Fred Jones has only one phone number: 719-458-8596.

If you will be importing into more than one table, you must always have matching "zk Link" Relational fields in the data you are importing.

As explained below in Step 1, the way to access a related table is to open a window that displays that data. For example, to access the Phones table,
click the + button on the Student Info screen to create a new phone record, then select Import from the File menu.
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m Format Records

v Browse Mode 3B
Find Mode 3F
Preview Mode #U
View as Form
View as List
NamePrefix NameFirst NameLast Email ree AdrStreet2 | AdrCity
Ms. |Janie Stevens 2342 West Lake Clearlake
Dr
Mr. |Fred Miller fred@gmail.com 123 Western Way Clearlake
Ms. |Suzie Miller squzeeque@myspace.com 123 Western Way Clearlake
Mr. |Jason Givens jason@email.com 57 W. 13th Apt 12 Clearlake
A

Discovering Field Names

To find out the exact name of a field in the Studio Organizer, go to the data entry screen than contains the field you wish to know the name of and
select "View as Table" from the View menu. The field names are displayed at the top of each column. Explore this screen to gather as many field
names as you'll need, then select "View as Form" to return to the normal view.

Student #'s
If have student numbers you would like to import, always import them into the "StudentNum" field of the Students table.
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the Importing Steps

Please note: This is not the procedure for updating to a newer version of the Studio Organizer. Please follow the updating
instructions to transfer your data to a newer version of the Studio Organizer.

Since importing and exporting data requires quite a bit of trial and error, it's strongly suggested that you ask your computer
guru for assistance with this process.

Export from the Source

First, export the data from its original source to a text file. This text file becomes the bridge between the original data and the
Studio Organizer. How you will do this depends on the software you are using, but look for an "Export" or "Save as..."
command which will allow you to create a text file.

Optional: You may want to open this text file in a word processor, such as Microsoft Word, and remove any unwanted
characters which may be appended to the export. (Try using the Find & Replace command in your word processor.)

Importing Data into the Studio Organizer

Open the Studio Organizer and go the a screen which contains the type of data you would like to import. For example, if you
would like to import student data, go to the Student Info screen. If you would like to import telephone numbers, click the +
button on the Student Info screen to create a new telephone record. If you'd like to import inventory, go to the Inventory
screen.

Always import your student data first. Then you can import other types of data. If you will be importing into more than one
table, you must have a unique relational key field in the data you are importing. This field will match up with the
"zk Link pk" field.

Importing attendance data, go to the Windows menu at the top of the computer screen and select "att" to open the attendance
file. (Please disregard the Access Denied screen if you see one.)

Select "Import Records" from the File menu. In the Open dialog that appears

PC users click on the "Files of types" drop down menu, scroll zp and select "All files (*.*)"
Mac users click on the "Show" drop down menu and select "All Available."

Select the text file that contains the exported data and click Open.
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Import Field Mapping

Source: My Export.tab Target: [ Current Table ("Students”) m
Source Fields l ITarget Fields
Fred = ¢ NameFirst A
Miller =

Namelast p
StudentNum

zi_BgDataEntry_gc

zi_BgHelp_gc

zk_HelpTopic_gt

$
103 = %
4
$
$
— % zk_LinkGuest_gn
$
$
$
$
$

zi_RecordDisplay_ct

— zk_Link_pk

— NameFull

- NameReversed .

— NamePrefix - 5
<< ‘ Record 1 of 3 Arrange by: [ custom import order m

Character Set: [ Windows (ANSI) ‘-ﬂ
Import Action
® Add new records

() Update existing records in found set

Field Mapping
= Import this field
— Don't import this field

= Match records based on this field
() Update matching records in found set % Target cannot receive data

| Add remaining data as new records ( Define Database... )

( Cancel ) G-Impon-)

/

) Don't import first record (contains field names)

The Import Field Mapping dialog box is where data fields are matched.
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In the Import Field Mapping dialog box you will determine the importing order. To align fields, click on a
field name on the right, and drag it up or down to align it with the data on the left.

Use the "Arrange by" drop down menu in the top left corner to get started, then adjust the fields
individually as needed.

Click in the center row to place an arrow next to each field that will be imported. Uncheck any fields you
do not want to import. Leave "Add New Records" selected, then click Import.

Be sure to check the “Perform auto-enter options while importing” box, otherwise the imported data will be
unusable in the Studio Organizer. You will receive an error message stating: Warning! 7%is record has no

Link # Import Options
. . . . . . . @ Perform auto-enter options while importin
Click Import and the importing will begin. A found ser of imported data will be created. o facs dte. sl Giinber: lookips. 2 9
R mport values in repeating fields by
Deletlng Imported Data *) Keeping them in the original record
This whole process requires a fair amount of trial and error as you discover which fields contains which Splitting them into separate records
o ) . . :
data, so it's very likely that you'll want to delete all of your imported data and try again. ("Cancel )

To delete your imported data, click the Delete button at the top of the screen, or select "Delete Record"
from the records menu. A dialog box will appear with a Delete All button. Click it to delete the entire found
set, that is, the records you've just imported. Now you can try your import again...

Importing Attendance Data
To import attendance data go to the Windows menu at the top of the computer screen and select Show
Window, then select "att" from the sub menu to open the attendance file. (Please disregard the Access
Denied screen if you see one.)

Next, go to the Scripts menu at the top of the screen and select Import Attendance File. Next, an Open

dialog box will appear. Select the file that contains the data you wish to import. Follow the above steps to
align field names and import data.
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Exporting Data

Specify Field Order for Export

t Current Table ("Students™)

&)

CustomTextl_Label
CustomText2
CustomText2_Label
CustomText3
CustomText3_Label
CustomText4
CustomText4_Label
Email

Employer
EmployerPhone
FamEmer
FamFather
FamMother
FamSpouse

Cender

Location

A
—~

)

3

( Clear
C Move All
( ClearAll

)

N
v

Options
Output file character set: : Windows (ANSI) Q

" Apply current layout's data formatting to exported data

Select and move the fields to be exported. If you want to group data, choose the 'Group by' fields before moving the
other fields.

Group by

(Unsorted)

Field export order

4 NameFirst
$# Namelast
$ StudentNum

( Cancel ) E-&cporl-a

/,
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Exporting Data from the Studio Organizer

Registered Users Only
Please note: This is not the procedure for updating to a new version of the Studio Organizer.
Please read (pdating 7he Studio Organizer in the built in Help under the Updating category.

Since exporting data requires quite a bit of trial and error, it's strongly suggested that you ask your computer guru for
assistance with this process.

Exporting Formats
Tab separated text, comma separated text, SYLK, DIF, WKS, BASIC, Merge, Data Access Manager.

To Export Data

Open the Studio Organizer using the Master password.

Select "Export Records" from the File menu. Click the Export button.

In the Save dialog that appears, create a name the export file, and select an export file format from the drop down menu at
the bottom.

In the Export Field Order dialog, select a table from the drop down menu above the left column. This will display the fields
in that table. (See Abour 7ables below.)

Select the fields you wish to export, then click the Move button or double click a field to move it.

Repeat steps 4 and 5 to add more fields to your export file.

Once you have the desired fields on the right, you can change the export order by clicking on a double arrow next to a field
name and dragging up or down.
Click the Export button.

About Tables

In the Specify Field Order For Export dialog box you'll find a drop down menu above the column on the left. Click on this
drop down menu to select a table. (Tables are grouping of information, such as Students, Phones, Notes, examine this Styles,
etc.)

There are many tables to choose from, so drop down menu to determine the fields you wish to export. For example, if you

want telephone numbers, you'll want to select one of the Phones tables. The export file you create can contain fields from
different tables.
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Troubleshooting Crashes

If your computer is constantly crashing, especially if the Studio Organizer is the o7/ program which is crashing, this a very
strong warning sign that there is some form of corruption on your computer. Power failures, hard drive errors, and operating
system corruption can all cause problems from time to time. Sometimes the corruption is minor, sometimes expert
maintenance is required.

The Studio Organizer was built using FileMaker Pro 11, a database application which has proven to be very, very stable. So
if the Studio Organizer is crashing, take it seriously. It's likely the problem will not fix itself. ESPECIALLY if the Studio
Organizer is the only program on your computer that is crashing. The problem is not within the Studio Organizer
programming, but how those program files are being executed, stored, open and closed on your computer.

At this point, it is highly recommended that you have your computer guru sit down at your computer and follow the
instructions below. This is very technical, and if your computer requires serious maintenance, this is something only an
expert level computer user should attempt. I've had years of experience with computers, and I can say without reservation
getting an expert involved now truly is the fastest, and most efficient path to a healthy computer.

If you are experiencing ongoing crashes, there are several possible reasons:

If you receive an error message stating a file has been damaged and needs to be recovered make a note of the name of the
damaged file name then follow the Aecovering A Damaged File instructions. The file to recover will usually be tSo5XX.tso,
where XX is the version number.

If the software crashes while using, you may have some form of data corruption, please read Cras/ing While Using.

If the software crashes when you open it, this usually means the application has become corrupted. Please read Cras/ing ar
Launch.

To restore your backup data from a crashed computer, please read Recovering From A Crash.

If none of the above correct the problem, there may be some form of corruption in your computers operating system, or there
is a hardware malfunction. Please read Operating System Corruption.
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Recovering from a Crash

The Studio Organizer makes it easy to backup your data files. Just go to the Wizards menu and select Backup Snapshot. This
will backup your data files, and place a dated backup folder on your Desktop. Copy this folder on to a USB flash drive every
day so you're never without a current backup. Now, if your computer crashes, you'll use these backup files to restore your
data.

But what if your computer has crashed and you don't have a backup? Fortunately, the backup files are also saved inside the
Dara folder inside the Srudio Organizer folder. Here's how to retrieve them:

* Locate your the Szudio Organizer folder on your hard drive. The default installation location for Windows computers is the
Desktop. On Macintosh computers, there is no default location, check the Downloads, Desktop or Applications folders.

* Open the Daza folder and copy these four backup files to a USB flash drive: Backup att.tso, Backup Ibl.tso,
_Backup data.tso, Backup oto.tso. Also copy the Srudent Photos folder.

Next, install a fresh copy of the latest version of the Studio Organizer. (If you're already using the most current version of the
Studio Organizer, please read Reznstalling 7The Studio Organizer.)

* Open the new Srudio Organizer folder.

* Copy the Szudent Phortos folder from the USB flash drive in the new Szudio Organizer folder, overwriting the old folder.
* Windows users open the Dazz folder.

* Copy the four backup files from the USB flash drive into the Dazz folder.

Open the new version of the Studio Organizer with the Master password. (Be sure to launch the #zew version. It should be
unregistered and contain only the sample data.) Then select "Restore Backup Snapshot" from the Wizards menu in the menu

bar at the top of the screen. This will restore your most recent backup data into the new version of the Studio Organizer.

If necessary, go to the Main Menu and click the Purchase button, and reenter your Registration Code. (Your old Registration
Code was imported with your backup data. If it's expired you'll have to enter the new Registration Code now.)

At this point you should have all of your backup data in a fresh, registered version of the Studio Organizer.
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Recovering a Damaged File

NOLO. Select Damaged File
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If you see an error message stating a file has been damaged and cannot be opened, don't worry. The 7ecovery procedure will create a new file and
salvage as much of your data as possible.

Your Studio Organizer files can become corrupt if you experience crashes, power failures, improper hibernation, or hard drive corruption.

Novice computer users will be over their heads on this one, so please get your computer consultant involved.
Also, please be sure to back up every day!

IMPORTANT!
Do NOT run Scan Disk, Disk First Aid, Norton Utilities or any other type of hard drive maintenance software until after you’ve completed the
Recovery procedure.

1) Quit/Exit the Studio Organizer.

2) Hold down these keys while you launch the Studio Organizer: PC Users - Control and Shift, Mac Users - Option and Command (propeller)
3) A Select Damaged File dialog box will appear.
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Recovering a Damaged File

the Studio Organizer 5v01

WARNING: problems were detected while recovering the database. Please review

the Recover.log file to see where problems were found and their severity. The

recovered file should NOT be used going forward; copy only the most recent
> work from it into a backup copy of the original file.

Recovery results:
File blocks: scanned and rebuilt 3593 blocks, dropped 0 invalid data blocks.
Schema: scanned fields and tables, 0 items modified.
Structure: scanned; 1 items modified.
Field indexes: rebuilt.

-

-

Open Log File... ;1

4) Locate the damaged file. It will be in the Dazaz folder inside the Szudio Organizer folder. Click on the file, then click the Select button.

5) A dialog box will appear displaying the recovery progress; rebuilding layouts and indexes, and cleaning up unused space. Small files will take a
few minutes, big files may take a few hours, but when it's done you'll see a dialog box giving you a progress report.

6) IMPORTANT! If this dialog box does not say "dropped 0 invalid data blocks" then the recovery procedure was only partially successful, and
some of your data was lost. During the recovery routine, any suspicious items in the database are deleted. You could lose entire records, a few
fields or entire screens. No one knows what gets deleted. If this is the case, you have two options:

a) Restore from your backup if you have one.

b) Update to the newest version of the Studio Organizer and import your data into the new files.

7) After a file has been recovered, the Selecs Damaged File dialog box you saw in Step 3 will reappear. This happens so you can recover multiple
files if needed.

Repeat Steps 3 through 7 until all damaged files have been recovered.
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Recovering a Damaged File

8) When you’re done recovering damaged files, click Cancel and the Studio Organizer will open.

9) After you’re satisfied all the files you recovered function properly, quit the Studio Organizer, then open
the Dara folder and delete any files with ‘old ’ in the filename. These are the damaged files.

3\ |
Finding the Source of Corruption
What caused the file to become corrupt in the first place? Did you improperly insert student photos? Could _5v01 Old.tso
it be a directory problem or physical defect on your hard drive? Maybe there's an operating system conflict —
or corruption. It could be the Studio Organizer application itself has become corrupted. Maybe your
computer crashed or there was a power failure. (Purchase an uninterruptible power supply.) All these are
suspects. The most important thing you need to do after recovering a file is to track down and eliminate the
culprit.

How do you do that? Run Norton Ultilities, Scan Disk, Disk First Aid or some other hard drive diagnostic.
Check your operating system and driver software, reinstall if necessary. Buy a UPS. Train your staff to quit
and shut down properly. Whatever you do, don't just ignore it, and hope it goes away.

If you suspect corruption but can't find it back up the hard drive, reformat it and install a fresh copy of the
Operating System. Install the latest driver software, download and install an empty copy of the Studio
Organizer from the web site, then import your data from your old files. Sound extreme? It’s not. You’re
covering all the bases in a lot less time and if there’s a hidden system file that’s corrupted, you’ll never find
it. Wiping the hard drive clean and starting from scratch is fast, efficient & it works.

If this doesn’t solve the problem or is beyond your abilities, please get a professional involved. Hire a
consultant or take the machine to the repair shop - don't ignore this. The Studio Organizer was created
using FileMaker Pro and it's a very solid piece of code. It’s your canary in the coal mine. If something’s
broken so badly that FileMaker won't run, take this seriously.
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Troubleshooting Crashes

Crashing While Using

If you are able to open the Studio Organizer with no error messages regarding damaged files, but using the software
inevitably results in a crash, make a note of the steps you are performing when the crash occurs. There could be data
corruption issue, or the Studio Organizer application itself could be corrupt.

The most common cause of crashing while using the Studio Organizer is a corrupted image file. If the Studio Organizer
consistently crashes when viewing a particular student, the student photo might be corrupted. Delete it from the Szzdens
Phortos folder.

The fastest way to test application or data corruption is to install a fresh, uncorrupted copy of the Studio Organizer. To do

this, please read Reznstalling 7The Studio Organizer.

Crashing at Launch
If you receive an error message stating the Studio Organizer application cannot open, this normally means the application
itself has become corrupted.

The fastest way to test for this is to install a fresh, uncorrupted copy of the Studio Organizer. To do this, please read
Reinstalling The Studio Organizer.
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Reinstalling the Studio Organizer

The fastest way to trouble shoot application or data corruption issues is to download and install the Studio
Organizer again. Before you do this, add the word ORIGINAL to the Szudio Organizer folder name. This
will prevent you from overwriting your data when you install the new version.

Once you've installed a fresh copy of the Studio Organizer, open it and perform the same steps that caused
the crash. If the software still crashes, even with the sample data and a fresh copy of the Studio Organizer
application, proceed to the Operazing System Corruption instructions.

If everything works fine, you can import your data into the new Studio Organizer. Here's how:

* Open the ORIGINAL Studio Organizer folder.

» Windows users open the Daza folder.

* Locate and copy these four backup files: Backup att.tso, Backup Ibl.tso, Backup data.tso,
_Backup oto.tso.

* Open the new Szudio Organizer folder.

» Windows users open the Dazz folder.

* Paste the four backup files.

Open the new version of the Studio Organizer with the Master password, then select "Restore Backup
Snapshot" from the Wizards menu in the menu bar at the top of the screen. This will restore your most
recent backup data into the new version of the Studio Organizer.

Experiment with this new version. If everything works properly, let's retrieve your Student Photos folder.
To do this, quit all versions of the Studio Organizer that might be running and open the ORIGINAL Studio
Organizer folder and copy the Szudent Photos folder. Next, open the new Studio Organizer folder and paste
the Szudent Photos folder, overwriting the folder that's already there.

Now, with the Photos in place, open the software and experiment. No crashes? Congrats! You've solved the
problem. If crashing continues, the photos could be the culprit. Please read Szudent & Stayf Photos in the
built in Help for important information about your photos.

Be sure to clean up your files as described on the next page.
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Cleaning Up After Reinstalling

You can move the Szudio Organizer folder to another location, with these warnings:
1) Always quit the Studio Organizer before moving the Szudio Organizer folder.
2) Do not move or rename any of the files inside the Szaio Organizer folder or subfolders.

3) PC Users: Do not move the Studio Organizer folder into the Program Files folder due to problems
caused by Windows Virtualization.

Compress & Backup

After reinstalling the Studio Organizer, be sure to compress the ORIGINAL Srudio Organizer folder. By

creating an archive of the old Studio Organizer folder you will prevent those files from being opened

accidentally. You're also keeping an archive of the files on your computer in case you need them in the tSo Backup 5
future.

Finally, to be on the safe side, run the Backup Snapshot Wizard every day. This will create a backup folder
on your Desktop. Copy this folder to your USB flash drive and take it home.

Duplicate Installations

It's possible to install more than one copy of the Studio Organizer on your computer then have two sets of
data files which cannot be merged. This is a computer housekeeping issue which is easily avoided. Please
read Only One Copy Of The Studio Organizer.
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Operating System Corruption

If your computer is crashing even after you've installed a fresh copy of the Studio Organizer this more than likely means
there is an operating system or hardware error on your computer.

To determine if your computers operating system or hardware is the culprit, download and install the latest version of the
Studio Organizer on a second computer. Open the software with the Master password, enter your Registration Code and
experiment with only the sample data.

If all is well, transfer all of your data following the Zraznsferring Files between School and Home instructions. Do not include
your Szudent Photos folder at first. They may be the source of the problem.

If the Studio Organizer does not crash on the second computer, you know there's an operating system or hardware problem
on the first computer. If that's the case, it's time to re-install the operating system on the first computer. This is a task best left
to a computer professional who can backup all of your data, reformat the hard drive, then reinstall the operating system. As
extreme as this sounds, this is often the fastest (and only) solution.

Your Computer Guru

If you're not 100% comfortable working with computers, please read 77%:s is Your Brain in the Free eBooks folder inside the
Studio Organizerfolder. If you're unfamiliar with the tasks technical support is asking you to perform, you will need
computer professional to visit your computer.

When trouble rears it's ugly head the fastest and most efficient solution is to let a professional tackle the problem.

There's just no substitute for having a computer expert right there in the room with you, teaching you new skills, solving
problems, and answering your questions. Computers are complex contraptions and finding your personal computer guru is as
important as having a good mechanic or doctor. Don't go it alone, you'll be much more productive if you have an expert

computer helper.

Don't want to hire a professional? Ask your students or parents. There's sure to a knowledgeable computer user who will be
happy to assist you. Read 77%is is Your Brain for more about finding a computer guru.
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